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1 About this document
This operation manual is a part of the software. It describes the basic functions and
provides information on the use of the software.
The software is used in conjunction with BUCHI instruments.
When operating the instrument, follow the respective operating instructions.
Keep this operation manual for later use and pass it on to any subsequent user or
owner.
BÜCHI Labortechnik AG accepts no liability for damage, faults and malfunctions
resulting from not following this operation manual.
If you have any questions after reading this operation manual:
u Contact BÜCHI Labortechnik AG Customer Service.

https://www.buchi.com/contact

1.1 Mark-ups and symbols
NOTE
This symbol draws attention to useful and important information.

R This character draws attention to a requirement that must be met before the
instructions below are carried out.

u This character indicates an instruction that must be carried out by the user.

ð This character indicates the result of a correctly carried out instruction.

Mark-up Explanation

Window Software Windows are marked-up like this.

Tab Tabs are marked-up like this.

Dialog Dialogs are marked-up like this.

[Button] Buttons are marked-up like this.

[Field names] Field names are marked-up like this.

[Menu / Menu item] Menus or menu items are marked-up like this.
Status Status is marked-up like this.
Signal Signals are marked-up like this.

1.2 Trademarks
Product names and registered or unregistered trademarks that are used in this
document are used only for identification and remain the property of the owner in
each case.

https://www.buchi.com/contact
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2 Product description

2.1 Description of function
The software is used for the maintenance and optimization of calibrations for
ProxiMate™ instruments.
The software allows exploration, visualization and treatment of the calibration data.
The software maintains all data in project files.

2.2 Files and folders of a project
The project file contains references to other files e.g. calibration.
Exact location and explanations of the file types. See Chapter 12.3 "File explanations
and folder locations", page 31

NOTE
Name the .prj, .cal, and .rtf files according to the following schematic:

u applicationname.property.filetype

A calibration consists of different files that are stored in different folders.

Navigation path

➔ [Desktop] ➔ [Data] ➔ [Data] ➔ [Calibrations]

NOTE
The location of the destination folder is fixed. See Chapter 12.3 "File explanations
and folder locations", page 31

File structure Explanation
[Calibrations]
(folder)

[Data] (folder) Additional .tsv files

[History] (folder) Old versions of the .cal/.prj/.rtf files.
These files are labelled with date and time
and are restorable.

[Local] (folder) Contains .tsv files that were generated by
the AutoCal function.

.cal (file) Calibration file

.prj (file) Project file

.rtf (file) Calibration report file
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2.3 User interface

3
7

6

1 2

45
Fig. 1: User interface of the software

No. Description Function
1 Menu bar Shows the program menu.

See Chapter 6 "Menu bar", page 17
2 Tool bar Shows the available tools.

See Chapter 7 "Tool bar", page 18
3 Project panel Editing project data and calibration settings.

See Chapter 8 "Project panel", page 19
4 Graph panel Shows the graphic results of a calibration.

See Chapter 9 "Table panel and graph panel", page 27
5 Status bar Shows the status of the software.
6 Table panel Shows numeric results which depend on the selection in

the project panel.
See Chapter 9 "Table panel and graph panel", page 27

7 Report panel Shows the report generated after computing a calibration
model.
See Chapter 10 "Report panel", page 28

2.4 Technical data
2.4.1 Computer system requirements

The software is designed to operate with the ProxiMate™ instrument.
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3 Installation

3.1 Installing the software
Precondition:
R The windows™ passwords are known.
u Double click the file Setup.exe.
ð The software installation client start.
u Single click [Install NIRWise Plus™].
ð The software starts the installation process.

u Single click the button [Next].

u Single click the Radio button next to I accept
the terms in the license agreement.

u Single click the button [Next].

u Single click the button [Install].

u Wait until the software shows the dialog [Instal-
lationShield Wizard Completed] .

u Single click the button [Finish].
ð The software is installed.
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3.2 Software settings
3.2.1 General settings

NOTE
Changing the default settings ​​is at your own risk.

Navigation path

➔ [View]

u Navigate to the [View] menu.
u Single click the action [Options].

ð The software shows the dialog box Options .

u Modify the options according to your needs.
u Single click [OK].
ð The settings are saved.
ð The dialog box close.

The following settings are available:

General tab

Action Option Explanation
[Load the last project on
startup]

- No function

[Outlier sigma distance
calibration]

Enter value Defines the limit of outlier detection
for the calibration set.

[Outlier Mahalanobis dis-
tance]

Enter value Defines the limit of outlier detection in
terms of the Mahalanobis distance.

[Outlier sigma distance
validation]

Enter value Defines the limit of outlier detection in
validation set.

[MLR/SVD/RR Factors to
compute]

Enter value Determine maximum number of fac-
tors to compute.

[PC’s to compute] Enter value Maximum amount of PCs used for
calculation.
Used by PCR/PLS/XLS

[PC Loading precission] Enter value Precision to maximize the variance of
the PC loadings



3 | Installation Büchi Labortechnik AG

10/34 Operation Manual NIRWise PLUS Software

Action Option Explanation
[Plot X-Axis as Wavenum-
bers]

Enable / disable Option to show X-axis in wavenum-
bers instead of nanometer.

[Sample ID repeat separa-
tor]

Enter value Defines the character used as an ID
repeat.
Default ID separator is [_]
Sample named [A_1], [A_2], [A_3]
represents the same sample.

[Delete outliers] Enable / disable Outliers detected by the software are
not used for the calculation.

[Delete repeat] Enable / disable Calculating until no more outliers are
found.

[Factors by minimum max-
imum residual]

Enable / disable Chooses the amount of factors based
on the residuals, when the amount of
factors is not entered manually.

[Adjust Targets With ID] Enable / disable
Enter value

Makes a twofold calibration.
1. against original target values or

laboratory reference values

2. original target values of selected
measurements are replaced by
their estimated value

This function allows to:
� balance weight of large and small

data-sets
� make optimization for e.g.

temperature variation by having all
samples but the temperature
samples adjusted after first pass

[Adjust Targets for Hierar-
chical calibrations]

Enable / disable No function

[Maximum Number of
Samples per Table]

Enter value To reduce data in large structures.
To use N fresh samples only.

[Create root reference] - No function

[Exclude first N composi-
tion]

- No function

Edit tab
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Action Option Explanation
[Autocomplete] Enable / disable no function

Save tab

Action Option Explanation
[Create Backup files] Enable / disable Auto save function.

[Create restore informa-
tion]

Enable / disable Time between carrying out the Auto
save function.

Expert tab
NOTE
BUCHI application support only.

3.3 License management
3.3.1 Applying for a license

NOTE
Only standard characters are allowed.

The following data is necessary for the license request:
� Article name
� Software license serial number (sticker on the cover page of the Quick Guide)
� Company name
� First name
� Last name
� Serial number (of the instrument)
� Country
� Email address

Navigation path

➔ [Help]
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u Navigate to the [Help] menu.
u Single click the action [License request].
ð The display shows a dialog with the mandatory

information needed for application.
u Enter your data.
u Tap the button [OK].
ð The dialog box closes.
u After entering all mandatory data tap the button

[OK].
ð The application file is created.
u Save the application file on your instrument.
u Send the file to registration@buchi.com.

3.3.2 Importing a license
Navigation path

➔ [Help]

Precondition:
R The license file .lic is available on the instrument.
u Navigate to the action [Import License] via the navigation path.
ð The display shows a dialog for choosing the folders on the instrument.
u Navigate to the saving folder of the license you wish to import.
u Select the file.
u Tap the button [OK].
ð The software imports the license.
u Start the software again.
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4 Operating the software

4.1 Operating the project panel
4.1.1 Deleting an entry

u Single click on the parameter
u Press the key Delete.
ð The entry is deleted.

4.1.2 Entering a value
Red marked characters mean incomplete or wrong entry.

NOTE
Only if the corresponding checkbox is activated, the entry will be processed.

u Single click on the parameter.
u Press the key F2.
ð The display shows an entry box.
u Enter a value.
u Press the key Enter.
ð The value is saved.

4.1.3 Entering a value from a drop-down menu
NOTE
Only if the corresponding checkbox is activated, the entry will be processed.

u Single click on the parameter.
u Press the key F2.
ð The display shows a drop-down menu.
u Single click the entry you wish to use.
ð The drop-down menu close.
ð The value is saved.
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4.1.4 Sorting entries
u Select the entry you wish to move.
u Press the key Shift.
u Press the curser key Up or Down.
ð The entry moves according to your entry.

4.2 Operating graph panel and table panel
4.2.1 Select various entries

u Press the Shift button and select with the left mouse key the table entries.

4.2.2 Zoom out
u Press the right mouse key and move the cursor

diagonal from right up to left down.

4.2.3 Zoom
u Press the right mouse key and move the courser

diagonal from left down to right up.

4.2.4 Rotate three-dimensional graphs
u Press the left Ctrl key, the left mouse key and

move the mouse.

4.2.5 Carrying out a calculation
Navigation path

➔ [Compute]

Precondition:
R All settings have been selected. See Chapter 8 "Project panel", page 19
u Single click the [Compute] menu.
ð The status bar shows the progress of the calculation.
u Wait until the software shows the result.
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5 Basic operations

5.1 Optimizing a calibration
Precondition:
R A calibration from the ProxiMate™ with reference values is available.
R If necessary, additional data files are available in the data folder.
u Open a project. See Chapter 5.2 "Open an existing project", page 15
u If necessary, add a data file to the project. See Chapter 8.1 "Project file settings",

page 19
u Change the project selector settings according to your requirements. See

Chapter 8.2 "Project selector settings", page 19
u Change the project pretreat settings according to your requirements. See

Chapter 8.3 "Project pretreat settings", page 20
u Change the project model settings according to your requirements. See

Chapter 8.4 "Project model setting", page 21
u Carry out a calculation. Chapter 5.5 "Carrying out a calculation", page 16
u Check the results. See Chapter 9 "Table panel and graph panel", page 27
u Adjust the settings according to your needs.
u Export the calibration. See Chapter 5.6 "Exporting a calibration", page 16
u Save the project.

5.2 Open an existing project
Navigation path

➔ [File]

u Navigate to the [File] menu.
u Single click the action [Open].
u Select the project you wish to open.
u Single click the button [Open].
ð The software opens the file.
ð The project is loaded into the software.

5.3 Creating a new project (BUCHI application support only)
Navigation path

➔ [File]

u Navigate to the [File] menu.
u Single click the action [New].

ð The software shows the dialog box Save project .
u Select the save location according the rules. See Chapter 12.3 "File explanations

and folder locations", page 31
u Enter the name of the project.
u Single click the button [Save].
ð The new project is created.

5.4 Saving a project
Navigation path

➔ [File]
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u Navigate to the [File] menu.
u Single click the action [Save].
ð The project is saved.

5.5 Carrying out a calculation
Navigation path

➔ [Compute]

Precondition:
R All settings have been selected. See Chapter 8 "Project panel", page 19
u Single click the [Compute] menu.
ð The status bar shows the progress of the calculation.
u Wait until the software shows the result.

5.6 Exporting a calibration
Navigation path

➔ [Project]

u Navigate to the [Project] menu.
u Single click the action [Export].
u Single click the button [Save].
ð The calibration is exported.
ð The existing files are moved into the History subfolder.

5.7 Exporting a graph
Precondition:
R A graphic program is available (e.g. Paint).
R A calibration was carried out. See Chapter 5.5 "Carrying out a calculation",

page 16
u Single click right in the graph panel.
u Select [Copy as Picture].
ð The graph is saved in the catch.
u Past the graph in the graphic program.

5.8 Exporting a .tsv/excel file
Navigation path

➔ [File]

Precondition:
R A calculation was carried out. See Chapter 5.5 "Carrying out a calculation",

page 16
u Click the table in the table panel.
u Navigate to the [File] menu according to the navigation path.

ð The Save Matric.. .  dialog opens.

u Save the .tsv file in the requested folder.
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6 Menu bar
The following menus are available:

Menu Submenu / Action Explanation
[File] [New] Create a new project.

(BUCHI application support only)
[Open] Open a project.

[Open in History] Open a project from history folder.

[Merge] Merges .tsv files.
(BUCHI application support only)

[Save] Save a project.

[Save as] Save a project as.

[Save project with
data]

Save a project incl. all available data.

[Exit] Exit a project.

[Import NAX] BUCHI application support only.

[Export NAX] BUCHI application support only.

[Edit] [Undo] Available according to the operation.

[Cut] Available according to the operation.

[Copy] Available according to the operation.

[Paste] Available according to the operation.

[Clear] Available according to the operation.

[Select All] Available according to the operation.

[Insert] Insert row or column.
Available according to the operation.

[Remove] Delete row or column.
Available according to the operation.

[Name] Rename a column.
Available according to the operation.

[View] [Tools bar] Enable / disable the tools bar.

[Status bar] Enable / disable the status bar.

[Options] See Chapter 3.2.1 "General settings",
page 9

[Project] [Export model] See Chapter 5.6 "Exporting a calibration",
page 16

[Compute] Carrying out a calculation.

[Help] [License Request] See Chapter 3.3.1 "Applying for a li-
cense", page 11

[Installed Licenses] Shows a dialog with details about the li-
censes on this instrument.

[Import License] See Chapter 3.3 "License management",
page 11
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7 Tool bar
Icon Explanation

Create a new project.
(BUCHI application support only)
Open a project.

Open a project from history folder.

Save a project.

No function

Cut
Available according to the operation.
Copy
Available according to the operation.
Paste
Available according to the operation.
Undo
Available according to the operation.
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8 Project panel
The project panel shows the project in a tree structure.

NOTE
Only if the corresponding checkbox is activated, the entry will be processed.

1

Fig. 2: Project panel

1 Project panel

8.1 Project file settings
8.1.1 Adding a data file to a project

Precondition:
R A .tsv file is in the data folder is available. See Chapter 12.3 "File explanations and

folder locations", page 31
R A project is open. See Chapter 5.2 "Open an existing project", page 15
u Double click the action [<DblClick to load data file>].

ð The software shows the dialog Select Data Fi le .

u Select the data file you wish to add.
u Single click the button [Open].
ð The software adds the file to the project.

8.2 Project selector settings
Navigation path

➔ [Project panel] ➔ [Selector]

The Selector allows to add further criteria to define which samples are included in the
calculation of the calibration.

8.2.1 Changing the query of the project
Defines the mask used to search the data in the data files.

NOTE
The option true and false is defined by the ProxiMate™ firmware.

The following queries are possible:
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Action Option Explanation
[Check] [true] The sample is activated.

[false] The sample is deactivated.

[Recipe] BUCHI application support only.

[Composition] BUCHI application support only.

8.2.2 Changing the target parameter
Select the property for a calibration.

The commands for target parameter follow the following syntax:

Syntax: <parameter> <min> <max> <format>
Explanation: Name of the param-

eter
Parameter range Unit and deci-

mal e.g. 0.00 %

8.3 Project pretreat settings
Navigation path

➔ [Project panel] ➔ [Pretreat]

8.3.1 Changing the basic pretreatment
NOTE
It is essential that the wavelength range (end wavelength – start wavelength) is a
multiple of the resolution (step size).

The instrument has a diode array detector.
Every diode detects the intensity for a certain wavelength.
The diodes are distributed over the whole wavelength range.
The .tsv file contains absorbance data collected at each pixel by the detectors.
To display spectra from these single values, a spline function is applied according to
the below settings.
The commands for basic treatment follow the following syntax:

Syntax: <Spline> [#]X1 [#]X2 [#]X3 <number> <number> <number>
Explanation: Index

of the
first
pixel

Index
of the
last
pixel(s
)

A
string
with
the
set(s)
of
poly-
nomial
coeffi-
cients

Wavelength range
(depending on the in-
strument configuration)

Wave-
length step
size

8.3.2 Changing the advanced pretreatment

Mathematical pre-treatment is used to minimize artifacts and enhance the spectral
data.

NOTE
The order of the pretreatments affects the result of the calculation of the calibration.
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The following pretreatments are available:

Parameter Explanation
[SMOOTH] Smoothing over 5 data-points along each spectrum.

[DG] 1. Number: derivative
2. Number: number of data points
3. Number: number of data points for smoothing

[SNVT] Subtracts the average and divides by the standard-deviation of the
vector.

[AVG] Calculates the average of repeated measurements.
Repeated measurements hold same sample ID.
Calculates the average of two consecutive x and y values.
The sample ID does not matter.

[NOIMAGE] No function

8.4 Project model setting
Navigation path

➔ [Project panel]➔ [Model]

8.4.1 Changing the regression method
NOTE
If a plus sign is added to the method the software will automatically select significant
wavelengths (68% Relevance) for each factor. E.g. PLS+ or RR+. A double plus e.g.
PLS++ will select 95% relevance.

The following regressions are available:

Parameter Explanation
PLS (Type) Standard PLS-Method.
XLS (Type) PLS with optimized first derivative.

8.4.2 Changing the validation
NOTE
Choose either validation or cross validation.

Validation determines the number of samples used to validate the calculation.
The following codes are possible:

Code Explanation
x Selects every x spectra for the validation.
x:y Selects y samples in each group of x samples for the validation.
x:-y Selects the last y samples in a group of x for the validation.
-x Selects the last x spectra for the validation.
ID x Selects every x spectra by ID for the validation.

8.4.3 Changing the cross validation
NOTE
Choose either validation or cross validation.
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Each sample will be used for the calculation and the validation of the calibration.
Therefore, the samples are divided into groups.

Parameter Explanation
5 (CrossValidate) Divides all calibration samples into five groups.

One of the five groups will be used to validate the
calibration (20%), while the other 4 groups are
used to calculate the calibration.
The classification of the groups changes with each
calculation.
In a cycle of five calculations, each group is once
the validation group.

10 (CrossValidate) Divides the samples into 10 groups.
10% of the samples will be used for the validation
at one time.
The classification of the groups changes with each
calculation.

99999 (CrossValidate) Leave out one, permutations equal to number of
samples.
Only one sample will be used for the validation at
one time.
All the other samples are used for the calibration.

8.4.4 Changing the factors
Select the number of factors for the calculation.

NOTE
If the checkbox is not selected, the software selects the number of factors.

8.4.5 Changing the auto delete
Determine what samples to remove from the calibration and validation data,
according to the settings for Mahalanobis and residual.

Number <Number> <Number> <Number>
Explanation Standardized cali-

bration residual
Mahalanobis
distance

Standardized valida-
tion residual

8.4.6 Delete
Defines a sample which will not be used for the calculation (after the first calculation
when it is clear which sample does not fit the model).
u Enter the sample ID manually in the field.

or
u Copy paste the samples from the calibration plot.

8.5 Project pretreat results
NOTE
Only bold mark-up results contain data.

Navigation path

➔ [Project panel] ➔ [Pretreat]

The following results are available
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Result Explanation Output
table

Output graph

[Wavelengths] Table of used wavelengths + -

[SNRs] Vector of instrument serial-
numbers

+ -

[WLCs] Vector of instrument wave-
length calibrations

+ -

[Means] Table of spectral means for
each data-set

+ -

[Targets] Reference values + -

[OSC] No function + -

[Variations] Matrix of variance for each
data-set

+ -

8.6 Project model results
NOTE
Only bold mark-up results contain data.

The results are shown in the graph panel and/or in the table panel. See Chapter 9
"Table panel and graph panel", page 27

Navigation path

➔ [Project panel] ➔ [Model]

The following results are available:

Result Explanation Output
table

Output Graph

Wavelengths Vector of the used wave-
lengths.

+ -

Indexes List of sample indexes. + -

IDs List of sample IDs. + -

Center Average of all reference val-
ues.

- -

Target List of reference values.

Zero Table of mean spectra. + -

Observations Shows the spectra included
in the calculation and valida-
tion of the calibration.
(only spectra with reference
values set as true and from
selected data files are shown
here)

+
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Result Explanation Output
table

Output Graph

ObservationsZ
(=Observation
Zero)

Shows spectra to find areas
with high amount of spectral
information.
The mean spectrum is sub-
tracted from each spectrum.

+

Weights Matrix of projected values.
Represents extracted fea-
tures of the spectra.
(e.g. for PLS, the correlation
between spectra and refer-
ence values; for PCR, maxi-
mized the variance of the
spectra)

+

Loads Describe the correlation be-
tween original spectra and
scores.

+ +

Scale Standard deviation of the
scores.

+ -

Regressions Weights multiplied by the
standard deviations of the
spectra (by wavelengths/col-
umn).

+ +

Press Visualizes the change of the
SEC and SECV with the
amount of factors.
For optimizing the number of
factors.

+

Scores Matrix of projected spectra,
as defined by the weights.
Contains information on the
estimations of the reference
values based on the used
number of factors.
For identifying groups of
samples.
If there is more than one
group, change the calibra-
tion.

+
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Result Explanation Output
table

Output Graph

Scores Scaled Table of standardized scores
obtained by dividing the
scores by the scales.

+

Mahalanobis The Mahalanobis is a mea-
sure of spectral similarity be-
tween the measured spec-
trum and the dataset used in
the calibration.
For identifying outliers.

+

Residuums The (Euclidean) distance of
the given spectra to the re-
constructed spectra.

+

Bias A bias is a constant value.
This value is added to the re-
sult of a prediction to correct
a constant deviation between
predicted values ​​and refer-
ence values.

+ -

Estimates Predictions based on calibra-
tion.

+

Skew No function - -

SkewBias No function - -

Residuals Difference between refer-
ence and estimated values.

CVEstimates Predictions based on the cal-
ibration during cross-valida-
tion executions.
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Result Explanation Output
table

Output Graph

CVResiduals Difference between refer-
ence values and CVEsti-
mates.

TEstimates Estimates per sample.

TResiduals Residuals per sample.
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9 Table panel and graph panel
The table panel and the graph panel are showing the results of the calculation.

21
Fig. 3: Results

1 Table panel 2 Graph panel

NOTE
A selected table entry in the table panel is highlighted in the graphic in the graph
panel. See Chapter 8.5 "Project pretreat results", page 22 and Chapter 8.6 "Project
model results", page 23
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10 Report panel
The report panel shows report data about the calibration.

1

Fig. 4: Report panel

The data is exported together with the calibration export.
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11 Troubleshooting
Problem Possible cause Action
Computation error The project contains no data. u Check if there is a data file

attached to the project (project
window, file).

u Check if the directory of the
data file is still correct by
clicking on it.

u If message says [file not
found], double click on data
file and load it again from the
correct directory.

No data selected. u Check if data file contains
reference values by clicking on
the file in the project window.

u If so, check if ‘Check’ is set to
‘True’ for samples exhibiting
reference values.

Too few data. u Less than three reference
values in one of the data files.

Wrong results The wavelength range is out-
side the range of available
data.

u Press abort and check if the
wavelength range in the
chosen spline (project window,
pretreat) fits the
measurements.
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12 Appendix

12.1 Explanation of terms
Term Explanation
Chemometrics The interpretation of spectral data to determine chemical

composition with the use of mathematical and statistical
methods.

Regression Solving an equation for its unknowns.
Regression methods The mathematical or procedural way by which the equation

is determined.
Multiple Linear Regres-
sion

Is a method of solving equations where you have many
variables that in a linear combination represent the target.
Various methods are used depending on numerical and
stability properties of your data, SVD (Singular value de-
composition) or RR (Ridge Regression).

Principal Component
Regression

This method is a combination of data-reduction and Multi-
ple Linear Regression, where the data is approximated by
a fewer number of variables that are later used to solve the
equation.

Partial Least Squares This method is similar to the Principal Component Regres-
sion though the eigenvectors are calculated to maximize
the covariance to the target / target residuum.

Mahalanobis Orthonormal distance of a sample relative to its multivariate
structure.

Standard -deviation, -er-
rors

Standard deviations are used to determine the quality of a
model. Given a normal distribution the value represents the
spread of 68% of the population examined.

Standardized residuals Divide the individual residual with its population standard
deviation. <1 = 68%=GOOD, <2=95%=OK,
<3=99%=QUESTIONABLE, >3=WRONG!

Pre-treatment Pre-treatments are mathematical reformatting functions of
the original measured signal.
These pre-treatments are needed to e.g. cancel particle
size effects, remove baselines etc.

12.2 List of abbreviations
Abbreviation Explanation
MLR Multiple Linear Regression
PC Principal Component
PCR Principal Component Regression
PLS(R) Partial Least Squares
XVAR Data Set Observation Variation
XCVAR Calibration-set observation variation
XVVAR Validation-set observation variation
SEC RMS of calibration residuals
CMAX Maximum calibration residual
SECV RMS of cross-validation residuals
CVMAX Maximum cross-validation residual
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Abbreviation Explanation
SEP RMS of validation residuals
VMAX Maximum validation residual
QVAL Standardized ratio of residual when in and outside of calibra-

tion-set. (negative if outside yields lesser residual than in)
N Number of instances
X Observations
Y Target
XLS An extension of Partial Least Squares; to only use derivative in-

formation in the data. Replaces Partial Least Squares with de-
rivative pretreatment.

Press Predicted Residual Error Sum Square
The difference between the predicted values and the original
reference values.

RMS Root mean square

12.3 File explanations and folder locations
NOTE
Hidden folders

By default settings the following folder locations are hidden.

u Start the software [Windows Explorer] on the instrument.

u Navigate to folder options via the following navigation path: View ➔ Folder

Options ➔ View
u Activate the function [Show hidden files, folders and drives].

Explanation Type Folder
Calibration files .cal C:\ProgramData\BUCHI\NIR-

Wise\Calibrations
Data files for calibration .tsv C:\ProgramData\BUCHI\NIR-

Wise\Calibrations\Data
Device specific data files for cali-
bration

.tsv C:\ProgramData\BUCHI\NIR-
Wise\Calibrations\Local

Manually exported files with dif-
ferent content

diverse C:\ProgramData\BUCHI\NIRWise\Ex-
port\Data

LIMS system files .xml
.csv

C:\ProgramData\BUCHI\NIRWise\Ex-
port\LIMS

License request file .xml C:\ProgramData\BUCHI\NIRWise\Ex-
port\LicenseRequests

External References .brf C:\ProgramData\BUCHI\NIR-
Wise\References

Measurement Reports .xls / .pdf C:\ProgramData\BUCHI\NIRWise\Re-
ports

System Test Reports .pdf C:\ProgramData\BUCHI\NIRWise\Re-
ports\SystemTests

Measurement report templates .xls C:\ProgramData\BUCHI\NIR-
Wise\Templates
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Explanation Type Folder
Licenses .xml C:\ProgramData\BUCHI\LicenseMan-

ager\License
History files for NIRWise Plus diverse C:\ProgramData\BUCHI\NIR-

Wise\Calibrations\Local\History
Report from latest calibration .rtf C:\ProgramData\BUCHI\NIR-

Wise\Calibrations
NIRWise Plus project file, con-
taining all .tsv files and the set-
tings for the calibration

.prj C:\ProgramData\BUCHI\NIR-
Wise\Calibrations
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